
 

                                                                    



История создания Sibelius 
 
Братья-близнецы Бен и Джонатан Финн (Ben & Jonathan Finn) начали работу над Sibelius, еще, будучи студентами 
в 1987 году, и разрабатывали программу на протяжении шести лет. В 1993 году, после окончания Оксфордского и 
Кембриджского университетов, братья Finn организовали свою собственную компанию по продаже Sibelius, 
которая обрела мгновенный успех, и в течение следующего десятилетия развилась, превзойдя все ожидания,  
с офисами в США, Великобритании и Австралии, и клиентурой более чем в 100 странах мира. В 2006 году, 
Sibelius был приобретен компанией Avid, производителем известных программ Pro Tools, Media Composer,  
и продолжает развиваться, по сей день. Фактически,  Sibelius является самым популярным в мире музыкальным 
программным нотатором.  

Для кого эта программа? 
 
Sibelius может использоваться любыми музыкантами - от студентов, учителей, школ и университетов до 
композиторов, аранжировщиков, исполнителей, и ведущих мировых издателей. Возможно, это дань простоте 
использования и изысканности Sibelius, что одна и та же программа используется как в начальных школах, так и 
топовыми профессионалами. Sibelius можно использовать для написания музыки любого жанра, от классики до 
джаза, от рока до авангарда, от хора до симфонического оркестра. Среди наиболее известных пользователей 
Sibelius - дирижер Майкл Тилсон Томас (Michael Tilson Thomas), композитор Стив Райх (Steve Reich), хоровой 
композитор Джон Раттер (John Rutter), рок-гитарист Энди Саммерс (Andy Summers), джазовый музыкант Джейми 
Каллум (Jamie Cullum), и Королевская Музыкальная Консерватория в Лондоне. Самые известные издатели, 
например, Хэл Леонард (Hal Leonard), Music Sales and Boosey & Hawkes используют Sibelius как для 
традиционной публикации, так и для распространения музыки через Интернет напрямую в принтер клиента. 
Sibelius стал обладателем награды Key Buy журнала Keyboard, пять раз становился лауреатом премии Editors’ 
Choice журнала Electronic Musician, дважды лауреатом 5 звездочного рейтинга журнала Macworld, и трижды 
набирал 10/10 очков рейтинга журнала Computer Music. 
 

Некоторые особенности базовой терминологии мануала 
 

 Большая часть компьютерной терминологии, используемой в данном мануале, будет понята практически 
всем читателями, но есть некоторые особенности, на которые следует обратить внимание, например, некоторые 
клавиши на различных клавиатурах маркируются по-разному, особенно на платформе Mac. Ниже приведена 
таблица символов на клавиатурах Mac и эквивалент этих символов на клавиатурах Windows: 
 

Символ Mac Название Mac Эквивалент Windows 

 
Command Ctrl 

 Ctrl Нет эквивалента 

 
Shift Shift 

 
Option Alt 

 
Return Enter (на основной клавиатуре) 

 Enter Enter (на цифровой клавиатуре) 
 
Обратите внимание на клавишу [Ctrl] (иногда [Control], в зависимости от модели клавиатуры) - на Mac она 
означает не то же самое, что клавиша [Ctrl] на Windows. Клавиатурные комбинации Mac с использованием 
клавиши [Ctrl] в Sibelius встречаются довольно редко, но там, где они есть, пишется символ , чтобы избежать 
путаницы для пользователей Windows.  
 

 Использование Sibelius практически идентично на Windows и Mac, но там, где есть различия, главным 
образом в обозначении клавиатурных комбинаций, в мануале первыми приводятся условные обозначения для 
Windows. Дополнительная информация о различиях клавиатурных комбинаций между Mac и Windows, приведена 
в конце мануала, в главе "Клавиатурные комбинации".  
 

 Предложение в мануале “Используйте [Ctrl+A], или [  A]" означает: удерживая клавишу [Ctrl] (Windows)  

или [ ] (Mac), нажмите клавишу с буквой "A". Если даже буква "A" будет написана прописной литерой,  
не нажимайте клавишу [Shift], чтобы сделать ее строчной, если об этом не будет оговорено особо. То же самое 

правило применимо для стандартных клавиатурных сочетаний, таких как [Ctrl+?] или [ ?], где оба символа – «/» 
и «?» расположены на той же самой клавише клавиатуры. Вы фактически нажимаете [Ctrl +/] или [ /], не 
используя клавишу [Shift].  
 



 Точно так же выражение “[Alt+щелчок] или [  + щелчок]” означают: «щелкните на... удерживая клавишу [Alt] 
(Windows) или [ ] (Mac)».  

 
Лента - широкая панель с кнопками наверху интерфейса Sibelius, включающая все функции программы, 
организованные согласно определенным задачам. В дополнение к ленте каждое окно документа Sibelius также 
содержит некоторые полезные контроллеры.  
 

Интерфейс Sibelius  
 
На рисунке ниже изображен типичный интерфейс Sibelius. Ниже рисунка приведено краткое описание элементов 
интерфейса сверху вниз: 
 

 
 

Панель Быстрого Доступа (Quick Access Toolbar). Доступна только на Windows. 
Включает три важные функциональные кнопки: Save, Undo и Redo.  
 

 
 
 
 



Кнопки Undo и Redo в свою очередь включают собственные меню, обеспечивая быстрый доступ к 
любой точке отмены (Undo) или восстановления (Redo), начиная с загрузки партитуры. На Mac эти 
опции расположены в меню File и Edit соответственно.  
 
 
 
 

 
Заголовок (Title bar): Отображает название файла документа, и название текущей 

 или просматриваемой версии. На Windows, если партитура динамической партии
включает несохраненные изменения, после названия файла отображается символ «звездочка» (*). На Mac 
вместо звездочки в верхнем левом углу интерфейса отображается черная точка в красной кнопке. 
 
Д инамическ ие партии 

Некоторые нотаторы требуют "извлечения" отдельных партий для каждого инструмента в отдельные файлы. Это 
означает, что если возникла необходимость внести изменения в оркестровую партитуру (например, после первой 
репетиции), Вам пришлось бы вносить эти изменения во всех партиях, либо извлекать их повторно, тратя на это 
уйму времени. Sibelius использует революционный подход: любое изменение, сделанное в партитуре, 
автоматически вносится в партию, и наоборот. Динамические партии можно редактировать точно так же, как и 
партитуру. Вы можете перемещать, добавлять и удалять ноты, добавлять лиги, динамику и т.д. Но всякий раз, 
когда Вы что-либо изменяете в партитуре, динамические партии будут тут же обновлены, и наоборот и для этого 
динамические партии извлекать необязательно. Плюс ко всему, все динамические партии сохраняются внутри 
того же самого файла, что и оркестровая партитура - и поэтому их легче организовывать. 

 
Кнопки управления окна (Window buttons): Заголовок включает ряд кнопок для 
управления текущим Окном. На Windows эти кнопки расположены в верхнем правом углу, на 
Mac они расположены в верхнем левом углу.  
Minimize  - первая из трех кнопок на Windows, и средняя на Mac. Щелчок на этой кнопке (1)
сворачивает Окно партитуры, не закрывая файл.  
Restore down/Maximize (на Mac называется Zoom) ) - вторая из трех кнопок на Windows, и (2

третья на Mac. Переключает размер Окна документа между максимальным размером и предыдущим размером.  
Close  - третья из трех кнопок на Windows, и первая на Mac. Щелчок по этой кнопке закрывает текущее Окно.  (3)
 

Область поиска (Find box): Напечатайте одно или более ключевых слов в 
этой области, чтобы просмотреть список соответствующих контроллеров на 

любой из вкладок Ленты. Это полезно в том случае, если Вы хотите найти контроллер или опцию, но не помните 
точно, где они находятся.  
 

По мере ввода букв, Sibelius отображает 
список соответствующих контроллеров 
или опций: используйте клавиши (↑↓) 
курсора клавиатуры для выбора 
элемента в списке, а затем нажмите 
[Enter]. Выбранный контроллер будет 
подсвечен на Ленте.  
 
 
 
 
 

 
Кнопка скрытия Ленты (Minimize Ribbon): Лента занимает определенное 
пространство окна по вертикали. Если Вы хотите отобразить дополнительное 

пространство партитуры, щелчок на кнопке Minimize Ribbon скроет Ленту, оставляя только Панель с названиями 
вкладок наверху окна. Повторный щелчок на кнопке Minimize Ribbon вновь отобразит полностью все вкладки 
Ленты.  

 
Кнопка Help: Щелкните на кнопке с символом "?", чтобы открыть английский 
мануал. Дополнительные файлы справки (Help) можно найти на вкладке File на 

Ленте.  
 

Панель вкладок документа (Document tabs): Можно 
открыть несколько различных представлений одного и 
того же документа - например, оркестровую партитуру и 

партии отдельных инструментов - в отдельных окнах, и переключаться между ними, используя эти вкладки. Когда 
Вы начинаете формировать новую партитуру, отображается только одна вкладка, маркированная Full Score. 



Новые вкладки можно открыть, используя кнопку "+" на правой стороне панели вкладок документа, или через 
другие опции переключения представлений (например, нажимая кнопку с буквой "W" на клавиатуре для 
переключения между оркестровой партитурой и динамической партией соответствующей партитуры).  

 
Открыть новую вкладку (Open new tab): Щелчок на кнопке с символом "+"  
отображает меню, с помощью которого можно открыть новую вкладку с другим 
представлением текущей партитуры, включая динамические партии и сохраненные 
версии. Чтобы открыть меню, необязательно нажимать кнопку "+" - достаточно 
щелкнуть правой кнопкой мыши на пустом месте Панели вкладок документа. Выбор 
опции New Window в самом низу меню открывает текущую вкладку в новом окне.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Кнопка переключения вкладок документа (Switch tabs): Если у Вас открыто несколько вкладок 
одновременно, все их названия могут не поместиться на Панели вкладок документа.  

 
Щелчок на этой кнопке отображает меню, в котором перечислены все открытые вкладки в 
текущем окне, позволяя быстро переключиться на любую из них.  
 
 
 

 
Строка состояния (Status bar): простирается внизу интерфейса и отображает информацию о текущем 
документе, а также включает некоторые полезные кнопки быстрого доступа. 
 

 
 
Информационные области (Information read-outs): На левой стороне строки состояния находится несколько 
полезных Информационных областей, количество которых меняется в зависимости от выполняемых задач.  
 

 
 
Слева направо:  
 
 текущая страница и общее количество страниц;  
 общее количество тактов; диапазон выделенного отрывка (от такта.. доли... до такта...доли...);  
 тайм - код выделенного отрывка;  
 тональная позиция выделенных нот (или первой ноты или первого аккорда выделенного отрывка;  
 гармония аккорда из выделенных нот в начале выделенного отрывка - отображается аккордовым символом;  
 описание текущей операции (например, Edit Passage или Edit Text); отображение тональных позиций нот 
текущего представления концертный (слышимый) строй или транспонированный (записанный) строй;  
 состояние активирования функций Layout->Hiding Staves->Focus on Staves; 
 состояние активирования функции Magnetic Layout для выделенных объектов;  
 шрифт и (или) размер точки выбранного текстового объекта.  
 

Контроллеры масштабирования (Zoom controls): На правой стороне строки 
состояния расположен слайдер с кнопками "-" и "+" с обоих концов. Слайдер и 
кнопки изменяют масштаб текущего представления. Налево от слайдера 
расположена информационная область, отображающая  текущий уровень 

масштабирования в процентах.  
 



Кнопки просмотра документа (Document view buttons): налево от контроллеров 
масштабирования расположен ряд кнопок, которые служат для переключения между 

различными типами представления, например между отображением страниц Вашей партитуры, по горизонтали и 
представлением Panorama. Эти кнопки продублированы на вкладке View на Ленте.  
 

Вкладки Ленты (краткое описание) 
  
Лента разделена на 11 вкладок.  
 

 
 
Первая вкладка, File, не похожа на остальные вкладки: щелчок на вкладке File скрывает 
партитуру, а вместо нее отображается специальное представление, которое называется 
Backstage и которое содержит все функции обращения С файлом (в противоположность 
опциям, которые применяются К файлу в остальных 10 вкладках). С вкладки File можно 
создать, открыть, сохранить и закрыть файлы, импортировать и экспортировать файлы в 
различные форматы, распечатать партитуру, получить доступ к специальным функциям 
обучения, получить подробную справку, и так далее.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Остальные 10 вкладок расположены в примерном порядке, в котором обычно выполняются задачи в работе над 
партитурой. 10 вкладок включают следующие типы команд:  
 
Вк ладк а  H ome 
 

 
 
Команды базовой конфигурации партитуры: добавление или удаление инструментов и тактов, операции 
редактирования тональности, операции с буфером обмена и мощные фильтры Sibelius. 
 
 
 
 
 
 
 



Вк ладк а  Note Input 
 

 
 
Команды, относящиеся к способам ввода нот (alphabetic, step-time и Flexi-time), операции редактирования нот, 
инструменты композиции (explode/reduce), инструменты преобразования (retrograde, inversion) и так далее. 
 
Вк ладк а  Nota tions 
 

 
 
Все основные обозначения, кроме нотных: паузы и текст, включая выбор ключей, тональности и музыкального 
размера, выбор специальных тактовых черт, линий, символов, типы нотных головок, и т.д. 
 
Вк ладк а  Text 
 

 
 
Контроллеры редактирования стиля шрифта и размера, опции выбора стилей текста, лирики, аккордовые 
символы, репетиционные пометки, и опции нумерации тактов и страниц. 
 
Вк ладк а  Play 
 

 
 
Опции воспроизведения, Микшер, транспортные кнопки (кнопки воспроизведения), функции Live Tempo и Live 
Playback, опции интерпретации программой Вашей партитуры при воспроизведении, и функции записи музыки к 
видео сюжету. 
 
Вк ладк а  Layout 
 

 
 
Опции конфигурации документа: размер страницы и нотного стана, шаг (распределение пространства) нотного 
стана, скрытие нотоносцев, опции функции Magnetic Layout, контроллеры форматирования. 
 
Вк ладк а  Appearance 
 

 
 



Опции, затрагивающие визуальное отображение партитуры: стиль, формат шага (распределение пространства) 
нот и названия инструмента, команды сброса или изменения дизайна или позиции объектов Вашей партитуры. 
 
Вк ладк а  Parts 
 

 
 
Опции инструментальных партий. 
 
Вк ладк а  Review 
 

 
 
Опции добавления и отображения комментариев, создания и управления несколькими версиями одной и той же 
партитуры, опции сравнения версий и доступа к различным плагинам корректуры (проверки).  
 
Вк ладк а  View 
 

 
 
Опции изменения расположения и размера партитуры на дисплее, опции отображения или скрытия различных 
"скрытых объектов" и других полезных обозначений, которые отображают полезную информацию о Вашей 
партитуре, опции скрытия или отображения панелей дополнительных операций, и опции расположения или 
переключения между открытыми документами.  
 

Группы и контроллеры 
 
 Каждая вкладка Ленты включает несколько групп, объединяя связанные команды. Название 
каждой группы отображается ниже названий отдельных команд текстом светло серого цвета. 
Группы отделены друг от друга вертикальной линией. Каждая группа содержит один или более 
контроллеров различных типов, включая  
 
 

 
  
 
нормальные кнопки  
 
 
 
   
кнопки, открывающие меню  

 
  
 
сдвоенные кнопки (где половина кнопки - это типичная кнопка, а другая половина открывает меню) 
 
 



 чебоксы 
 

комбинированные области и галереи (меню со специальными функциями). Галереи бывают двух разновидностей: 
 

 Выпадающие галереи (Drop-down galleries): могут походить на типичные меню, отображая содержание  
в виде текста, или могут отображать свое содержание графически. В отличие от типичных меню, галереи 
перечисляют опции, организованные по категориям, которые можно фильтровать (см. ниже).  
 
Пример текстовой галереи - Home-> Select-> Filters:  
 

 
 
Все кнопки в группе Notations->Common используют выпадающие графические галереи.  
 

 
 

 Галерея-в-Ленте (In-ribbon galleries): эти галереи встроены непосредственно в Ленту, отображая первые 
несколько элементов галереи, не открывая ее полностью. Галерея-в-Ленте содержит степперы на правой 
стороне, с помощью которых можно прокрутить вверх и вниз список элементов. Альтернативно, можно открыть 
галерею, щелчком по ней, которая отобразится в виде выпадающей галереи. Примеры Галереи-в-Ленте: 
Notations-> Lines и Notations-> Symbols.  
 

 
 
Большинство галерей в Sibelius включают фильтры категорий наверху открытой галереи, с помощью которых в 
галерее можно отобразить только одну категорию. По умолчанию, фильтр не активен (т.е. отображаются все 
категории, а фильтр принимает значение All), но если щелкнуть по названию фильтра, отобразится меню, в 
котором перечисляются все категории. Выберите одну категорию, и все остальные категории будут 
отфильтрованы. В зависимости от ширины окна на Ленте будет отображаться максимальное количество 
контроллеров всех групп текущей вкладки. Некоторые контроллеры можно расположить вертикально, освобождая 
место, или можно даже скрыть их текстовые описания. Если пространство становится слишком сжатым, 
некоторые группы могут скрываться. Это означает, что вместо того, чтобы отображать каждый контроллер группы 
непосредственно на Ленте, все контроллеры сворачиваются за одну кнопку со стрелкой вниз. Если щелкнуть по 
этой кнопке, ниже Ленты отображается все содержимое группы. 
 



 
 
На рисунке выше видно, что группы сжаты, а щелчок на кнопке группы Barline отображает фрагмент всех 
элементов этой группы. 

 
 Sibelius содержит очень много команд, и чтобы каждая группа на каждой вкладке Примечание:

отображалась полностью, разрешение Вашего монитора в ширину должно быть по крайней мере 1920 
пикселей!  

 

Доступ через клавиатурные подсказки 
 
Лента включает множество полезных функций, помогая быстро изучить и понять программу, основной из этих 
функций является возможность доступа к любой команде через клавиатуру компьютера, используя клавиатурные 
подсказки. Клавиатурные подсказки - специальные обозначения, которые соответствуют определенной команде 
на любой активной вкладке Ленты. Чтобы отобразить клавиатурные подсказки, нажмите [Alt] (Windows) или [Ctrl] 
(Mac). Удерживать эти функциональные клавиши необязательно. После чего, ниже названия каждой вкладки 
появится небольшое буквенное наложение:  
 

 
 
Чтобы получить доступ к вкладке, просто нажмите клавишу, соответствующую клавиатурной подсказке. 
Например, щелчок по клавише с буквой "L" переключит на вкладку Layout: 
 

 
 
После чего можно использовать клавиатурную подсказку (обычно две буквы) для вызова команды. Как только Вы 
сфокусировались на Ленте, нажав [Alt] (Windows) или [Ctrl] (Mac), можно перемещаться по вкладкам и 
контроллерам на любой вкладке, используя клавиши курсора клавиатуры или используя клавиши [Tab] и [Shift-
Tab], а затем использовать либо клавишу [Пробел], либо клавишу [Enter] для активирования кнопки или другого 
контроллера, сфокусированного в настоящий момент. 
 
 
 
 
 
 
 
 
 
 
 
 
 



Всплывающие подсказки 
 
У каждой команды в Ленте есть дополнительное текстовое описание, которое появляется при наведении мыши 
на команду. Эти описания называются всплывающие подсказки, и обеспечивают полезный дополнительный 
контекст для каждой команды.  
 

 
 
Заметьте, что после названия команды в круглых скобках отображается и клавиатурная комбинация для этой 
команды. В отличие от клавиатурных подсказок, которые могут использоваться только в последовательности 
после нажатия клавиш [Alt] (Windows) или [Ctrl] (Mac), этот вид подсказок может использоваться повсюду, и 
кроме того, отображение всплывающих подсказок можно настроить.  
 

Кнопка отображения диалоговых окон 
 

 У некоторых групп на Ленте присутствует маленькая дополнительная кнопка в нижнем правом углу, 
которая называется Кнопка отображения диалогового окна. Щелчок по этой кнопке отображает диалоговое 

окно, содержащее дополнительные опции, касающиеся команд этой группы.  
 

Сохранение рабочей среды Sibelius 
 
Sibelius автоматически отслеживает расположение окон и вкладок, во время работы над партитурой и 
восстанавливает это расположение при последующем запуске. Когда Вы вновь откроете партитуру, Sibelius 
выполнит следующие действия:  
 

 Откроет окно документа того же самого размера и в том же положении, в котором этот документ 
использовался при его закрытии  

 Откроет все вкладки, которые были открыты при последнем закрытии документа и выделит последнюю 
используемую вкладку  

 Установит тот масштаб и тип представления, которые использовались при закрытии документа  
 Восстановит параметры на вкладке View, которые были отмечены как "скрытые объекты" - объекты, 

которые отображаются на экране, но не распечатываются.  
 Откроет панели (например, панель Микшера, панель Ideas, и т.д.), которые были открыты при закрытии 

документа.  
 
Можно, конечно, настроить параметры отображения по Вашему усмотрению в опциях Display and Files на 
вкладке File->Preferences.  

 
Две из наиболее важных функций в Sibelius - функции отмены (undo) и восстановления (redo). Они обеспечивают 
переход к любому сделанному Вами шагу редактирования (действия), начиная с открытия партитуры до ее 
завершения. Доступ к этим функциям отличается для пользователей Sibelius на Windows и Mac.  
 

Для пользователей Windows  
 

 На Windows функции Undo & Redo расположены на Панели Быстрого Доступа, которая 
находится в верхнем левом углу любого окна документа Sibelius. Чтобы отменить 
последний сделанный Вами шаг редактирования, щелкните по стрелке, указывающей 

налево, или используйте комбинацию [Ctrl+Z].  
 



 Если выполнено несколько операций, щелчок на кнопке-меню отобразит меню истории 
функции Undo. Чтобы перейти непосредственно к определенному шагу редактирования, 
щелкните по соответствующему элементу меню. Чтобы восстановить последний 
отмененный шаг редактирования, щелкните по стрелке, указывающей направо, или 
используйте комбинацию [Ctrl+Y]. Так же как и в случае с функцией Undo, можно щелчок на 
кнопке-меню отобразит меню истории функции Redo.  
 
 
 
 

 
Для пользователей Mac  

 
На Mac функции Undo & Redo расположены в меню Edit.  

 Чтобы отменить последний шаг редактирования, перейдите в Edit->Undo, или используйте комбинацию   

[  Z].   
 Чтобы отобразить меню истории функции Undo, перейдите Edit->Undo History или используйте комбинацию 

[Ctrl+Shift+Z], или [   Z].  
 Чтобы восстановить последний отмененный шаг редактирования, перейдите в Edit->Redo , или используйте 

комбинацию [  Y].  
 Чтобы отобразить меню истории функции Undo, перейдите в Edit->Redo History или используйте комбинацию 

[Ctrl+Shift+Y], или [   Y].  
 
Установк а  мак симального к оличества  шагов  отмены  
Чтобы установить количество шагов отмены, перейдите File->Preferences->Other и переместите слайдер Undo. 
Максимальное количество шагов отмены - 30 000. 
 

 
 

 
Подключение внешних MIDI устройств условно можно разделить на три шага:  
 

 подключение аппаратного устройства  
 установка необходимого программного обеспечения (по необходимости)  
 конфигурация MIDI параметров в Sibelius.  

 
Данная глава посвящена первым двум шагам, а последний шаг описывается в главе "Устройства ввода 
данных".  
 

Подключение MIDI устройства к компьютеру  
 
MIDI - это аббревиатура термина Musical Instrument Digital Interface (Цифровой интерфейс музыкальных 
инструментов) и является универсальным стандартом для подключения электронных музыкальных инструментов. 
MIDI клавиатуры, синтезаторы, звуковые модули, сэмплеры и другие электронные музыкальные гаджеты можно 
подключить друг к другу через MIDI кабели, и напрямую в компьютер. Виртуальные инструменты и программные 
синтезаторы совместимы с MIDI, и так как они уже находятся внутри Вашего компьютера, для воспроизведения 
музыки подключения через кабели не требуют вообще. Все современные MIDI устройства, например, MIDI 
клавиатуры, подсоединяются напрямую к компьютеру через USB кабель. Более старые MIDI устройства без 
наличия USB порта можно подсоединить через промежуточный отдельный MIDI интерфейс, который в итоге 
подсоединяется с Вашим компьютером через USB порт, а также подключить MIDI устройство через MIDI 
интерфейс, используя MIDI кабели.  
 
 
 
 



Подключение MIDI устройств напрямую через USB  
 
Все новые MIDI клавиатуры и другие устройства могут подсоединяться напрямую в USB разъем Вашего 
компьютера без промежуточного использования отдельного аппаратного MIDI интерфейса. После подсоединения 
и установки необходимых драйверов, можно приступить к конфигурированию параметров ввода и 
воспроизведения в Sibelius (глава "Устройства ввода данных").  

 
: Питание подсоединенных MIDI устройств необходимо включить до запуска Sibelius. В Примечание

противном случае Sibelius может неправильно детектировать устройство при загрузке.  
 

: Некоторые устройства, не имеющие отдельного блока питания и которые запитываются Примечание
напрямую через USB кабель, будут правильно работать только в том случае, если подключены в USB 
разъем непосредственно на Вашем компьютере, а не к внешнему устройству, например, к USB 

концентратору (хабу) или, скажем, к Mac клавиатуре.  
 

Подключение MIDI устройств через промежуточный MIDI интерфейс  
 
MIDI Интерфейс - небольшое устройство, которое в цепи соединений помещается между Вашим компьютером и 
внешним MIDI устройством, принимая сигнал с клавиатуры и передавая сигнал в компьютер и наоборот. MIDI 
интерфейс обычно подсоединяется к USB порту Вашего компьютера и необходим только в том случае, если 
внешняя MIDI клавиатура не имеет своего собственного прямого USB разъема. Часто для использования MIDI 
Интерфейса необходимы дополнительные драйвера, которые предоставляются производителем устройства. 
Чтобы подключить только MIDI клавиатуру, соедините ее разъем “Out” с разъемом “In” MIDI интерфейса. Чтобы 
использовать поток данных с компьютера для воспроизведения музыки в клавиатуру, имеющую встроенные 
банки звуков, также соедините разъем “Out” MIDI интерфейса в разъем “In" клавиатуры. Если у Вашей 
клавиатуры два разъема “In” или “Out”, не имеет значения, какой из них Вы будите использовать - это всего лишь 
удобные копии друг друга. Подсоединение вышеописанной клавиатуры выглядит следующим образом:  
 

 
 
Если Вы хотите подсоединить только, скажем, звуковой модуль, без клавиатуры, просто соедините разъем “Out” 
MIDI интерфейса в разъем “In" звукового модуля. Как только Вы соединили Ваше MIDI устройство с Вашим 
компьютером, можно приступить к конфигурированию параметров ввода в Sibelius  (глава "Устройства ввода 
данных"). 

 
В данной главе объясняются функции сохранения партитур в формате Sibelius, и (для более продвинутых 
пользователей) способы получения доступа к пользовательским файлам Sibelius, например, к собственным 
издательским стилям (house styles). В остальных параграфах этой главы объясняется, как поделиться файлами 
с другими пользователями Sibelius, и рассматриваются функции импортирования и экспортирования файлов в 
различные форматы.  

Размер файла Sibelius  
 
Файлы Sibelius обычно занимают приблизительно 20 Kb плюс 1 Kb на страницу (за исключением любой 
импортируемой графики). Даже если партитура создана для большого ансамбля или оркестра, можно хранить 
буквально миллионы страниц на жестком диске, и даже огромные партитуры можно легко отправить по 
электронной почте.  
 



Опции сохранения  
 
Опции сохранения функционируют точно так же, как и в любой другой программе, используя меню File->Save As 

(комбинация [Ctrl+Shift+S] или [   S]) и меню File-> Save (комбинация [Ctrl+S] или [  S]). В дополнение к 
возможности сохранения партитур в формате Sibelius, можно также экспортировать другие форматы, такие как 
MusicXML, MIDI, аудио, и графика. Подробнее об этих форматах смотрите соответствующие главы мануала. 
Подробности сохранения лирики смотрите в главе "Экспорт лирики". Удобное место для сохранения - папка 
Scores, которую создает Sibelius. На Windows папка Scores создается в папке "Мои документы"; на Mac эта 
папка создается в папке "Документы". Местоположение папки по умолчанию для сохранения партитур можно 
изменить в File->Preferences->Files. После сохранения, когда Вы впоследствии открываете партитуру, она 
откроется в том месте, где Вы остановились перед ее сохранением, в том же окне и в том же самом положении, с 
теми же панелями и окнами, и даже в том же самом масштабе. Насколько Sibelius восстановит рабочую среду 
после сохранения, зависит только от Вас (глава "Параметры отображения").  
 

Функция Автосохранения  
 
Sibelius может автоматически сохранять Вашу партитуру с равными интервалами, позволяя предотвратить 
потерю данных и Вашего потраченного впустую времени. Вместо того чтобы сохранять фактический файл, 
Sibelius делает копию Вашей партитуры и сохраняет эту копию в специальную скрытую папку. Если работа 
Sibelius была завершена некорректно (например, при зависании компьютера или внезапном отключении питания), 
при следующем запуске, Sibelius проверит эту специальную папку, и если найдет там какие-либо сохраненные 
партитуры, последует запрос на их восстановление.  

 
: При корректном закрытии Sibelius, все файлы в специальной папке удаляются - поэтому Примечание

убедитесь, что в эту папку Вы случайно не сохранили важные файлы!  
 
 Функция автосохранения активируется по умолчанию, но если по 
каким-то причинам Вы хотите ее отключить, перейдите в File-> 

Preferences->Files и снимите чебокс Auto-save. Здесь же можно определить временной интервал, через который 
Sibelius будет автоматически сохранять Вашу партитуру. Значение по умолчанию - 10 минут.  
 

Папка сохранения резервных копий Backup scores  
и ее отличие от папки автосохранения  

 
Каждый раз, используя опции сохранения, партитура, с ее номером версии, добавленным к названию, также 
сохраняется в папку Backup Scores в папке Scores. Если Вы случайно удалили или испортили партитуру, 
перейдите в эту резервную папку и выберите последнюю сохраненную версию, или более ранению версию. Папка 
Backup Scores хранит 200 последних сохраненных партитур.  
 

 Число (200) всегда остается неизменным, удаляя более ранние версии для экономии Примечание:
дискового пространства, поэтому не используйте эту папку для сохранения Ваших пользовательских 
резервных копий!  

 
Папка Backup scores создается в том случае, если Вы сохраняете партитуру обычным способом, а не при 
использовании функции автосохранения Sibelius.  
 

: В отличие от автоматического сохранения, при закрытии Sibelius содержимое папки Backup Примечание
scores не удаляется.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



Информация о партитуре и тегирование 
 

 
 
Вкладка File-> Info может использоваться для заполнения информацией о Вашей партитуре соответствующих 
тегов, например, заголовок, композитор, аранжировщик, авторское право, и так далее, которые будут 
автоматически использоваться при публикации Вашей партитуры в Интернете (глава "Экспортирование 
партитур с помощью плагина Scorch"). Несколько областей будут уже заполнены в том случае, если при 
создании партитуры Вы определили заголовок, композитора, и т.д.  

 
 На правой стороне вкладки File-> Info отображается 
полезная информация о Вашей партитуре, 
например, дата создания, дата последнего 
сохранения, количество страниц, нотоносцев и 
тактов и так далее.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Значения, вводимые в областях вкладки File-> Info, могут также использоваться в качестве специальных 
символов (wildcards) в текстовых объектах Вашей партитуры. Для получения дополнительной информации о 
специальных символах и как их использовать в Sibelius, смотрите главу "Специальные символы".  
 
 
 
 
 
 
 



Доступные файлы для пользовательского редактирования  
 
Sibelius позволяет создавать Ваши собственные файлы следующих типов:  
 
 Идеи (глава "Идеи")  
 Собственные издательские стили (глава "Собственные издательские стили")  
 Плагины (глава "Работа с плагинами")  
 Черновики (глава " Worksheet Creator - Плагин для создания черновиков")  
 Стили построения партитуры (глава "Редактирование стилей построения партитуры")  
 Библиотеки аккордовых символов (глава "Аккордовые символы")  
 Библиотеки гитарных табулатур (глава "Гитарные табулатуры")  
 Текст и эквиваленты музыкальных шрифтов (глава "Работа с текстом" и глава "Музыкальные шрифты")  
 Нотное полотно (глава "Экспортирование нотного полотна")  
 Собственные установки функций (глава "Клавиатурные комбинации")  
 Словарь полезных слов (глава "Работа с текстом")  
 
Поскольку Sibelius включает фабричные установки каждого из вышеперечисленных типов файлов, любые 
дополнительные фалы, которые Вы создаете, сохраняются в папке, отдельной от папки с фабричными 
установками. Стандартные (фабричные) файлы Sibelius не удаляются и не редактируются. Ваши собственные 
(доступные для редактирования) файлы хранятся в специальных папках в папке Application data->Sibelius7 
Вашей учетной записи:  
 

 Windows: C:\Users\username\Application Data\Avid\Sibelius 7 \ 
 Mac OS X: /Users/username/Library/Application Support/Avid/Sibelius 7.  

 
Внутри этой папки Вы найдете различные папки, названия которых указывают на контент, который они содержат. 
На Mac там может не быть никаких папок вообще, поскольку они создаются только тогда, когда Вы создаете или 
редактируете файл, который сохраняется в этой папке. Файлы, которые Вы добавляете или создаете, можно 
удалять без боязни побочных эффектов.  
 

Шаблоны и фактуры Scorch 
 
Вы можете создавать свои собственные шаблоны и фактуры Scorch и поместить их в соответствующую папку в 
директории Application data. Шаблоны Scorch помещаются в папку Scorch templates, а фактуры (на Windows 
только в формате BMP) помещаются в папку Textures.  
 

Функция Quick Look в Sibeluis (только для пользователей Mac)  
 
Quick Look - функция, встроенная в операционную систему Mac OS X, которая обеспечивает мгновенный 
просмотр содержания Ваших документов напрямую с проводника (Finder), без необходимости открывать 
приложения, с помощью которых они были созданы. Просто выберите в Finder документ, и нажмите [Пробел]. 
Большинство документов также отображают свои ярлыки на рабочем столе и в окнах Finder, и если Вы 
устанавливаете окна Finder в опцию Cover Flow, Вы можете мгновенно отобразить папки этих документов. 
Sibelius полностью поддерживает функцию Quick Look, таким образом, вместо обычного значка документа, будет 
отображаться миниатюрное представление первой страницы партитуры. Чтобы развернуть партитуру, выберите 
ее и нажмите [Пробел] (или щелкните по значку Quick Look в Finder). Страницы можно прокручивать 
посредством полосы прокрутки на правой стороне представления.  
 

Поисковая система Spotlight в Sibelius (только для пользователей Mac)  
 
Spotlight - встроенная поисковая система на платформе Mac OS X. Щелкните по значку Spotlight в верхнем 

правом углу дисплея, или используйте клавиатурную комбинацию [  +Пробел], и введите критерий поиска. 
Партитуры в Sibelius, используя систему Spotlight можно искать простым вводом названия файла, или любого 
текстового отрывка, который содержится в партитуре (например, заголовок, композитор, лирика, название 
инструментов, и так далее). Как только Вы нашли одну или более партитур, просто нажмите [Пробел] для 
просмотра этой партитуры, используя функцию Quick Look (см. выше), или дважды щелкните на партитуре, 
чтобы открыть ее в Sibelius. 
 
 
 
 
 
 



 

Распространение файлов между пользователями Sibelius  
 
Если у Вашего визави также установлен Sibelius, Вы можете просто отправить файл по электронной почте (см. 
ниже), или переправить его, записав на съемные носители (флешка или CD диск). Но перед отправкой 
поинтересуйтесь, какую версию Sibelius использует Ваш партнер. Если у него установлена та же самая версия 
Sibelius, что и у Вас, или более поздняя версия, можно просто сохранить Ваш файл в обычном формате и 
отправить его партнеру. Однако если у него установлена более ранняя версия Sibelius (или он используют более 
ранние версии редакций Sibelius Student или Sibelius First), Вам необходимо будет экспортировать Вашу 
партитуру в формат более ранних версий (глава "Экспортирование партитур в форматы более ранних 
версий Sibelius").  
 

Распространение файлов между пользователями,  
которые не используют Sibelius  

 
Если Sibelius у партнера не установлен, есть несколько альтернативных способов поделиться Вашими файлами:  
 

 Попросите партнера, чтобы он загрузил и установил пробную версию Sibelius с сайта www.sibelius.com, а 
затем отправьте Ваш файл.  

 
: По истечении испытательного срока, trial версия может распечатать только одну страницу с Примечание

водяными знаками, поэтому если Вы хотите, чтобы партнер мог распечатать всю Вашу партитуру, это не 
лучший способ.  

 
 Опубликуйте музыку на своем собственном веб-сайте –  

(глава "Экспортирование партитур с помощью плагина Scorch").  
 Экспортируйте Вашу партитуру в PDF формат и отправьте ее партнеру –  

(глава "Экспортирование партитур в PDF-файл")  
 Экспортируйте партитуру в графический файл из Sibelius и отправьте его партнеру –  

(глава "Экспортирование партитур в графические файлы")  
 Сохраните партитуру в формате Scorch web page и приложите оба файла при отправке по электронной 

почте (см. ниже),  
 Если у получателя установлена другая музыкальная программа, и он хочет послушать и возможно 

отредактировать Вашу партитуру, отправьте ему MIDI-файл (глава "Экспортирование партитур в MIDI файл") 
или, предпочтительно, в файл MusicXML (глава "Экспортирование партитур в MusicXML файл").  

 Если Вы хотите отправить музыку, записанную с Вашей партитуры, без необходимости просмотра самой 
партитуры, Вы можете экспортировать партитуру в аудио файл из Sibelius, а затем либо прожечь этот файл на 
CD диск, либо сжать аудио файл в MP3 файл и отправить по электронной почте - (глава "Экспортирование 
партитур в аудио файлы").  
 

Отправка файлов по электронной почте  
 
Отправка файлов по электронной почте достаточно проста, но процедура отправки отличается в зависимости от 
установленного у Вас почтового клиента:  
 

 Windows Mail, Outlook Express или Mozilla Thunderbird: создайте новое письмо, а затем нажмите кнопку 
"Прикрепить" (со значком скрепки), найдите файл и щелкните "Прикрепить". Отправьте письмо.  

 Apple Mail: создайте новое письмо, а затем перетащите файл, который Вы хотите приложить к письму в окно 
сообщения. Отправьте письмо.  

 Eudora: создайте новое письмо, щелкните правой кнопкой мыши (Windows) или [Control+щелчок] (Mac) на 
тексте сообщения, и выберите "Прикрепить файл". Найдите файл, который Вы хотите приложить, и дважды 
щелкните по его названию. Отправьте письмо.  
 
Если Вы не используете ни одну из вышеперечисленных программ, проконсультируйтесь с документацией 
Вашего почтового клиента. Если Вы хотите отправить файл Sibelius в формате Scorch web page по электронной 
почте:  
 

 Во-первых, экспортируйте его (глава "Экспортирование партитур с помощью плагина Scorch")  
 Заархивируйте экспортируемые файлы форматов .sib и .htm в zip архив. Для этого выделите оба файла, а 

затем щелкните правой кнопкой мыши и выберите опцию "Отправить -> Сжатая zip папка" (Windows) или 
Compress 2 (Mac).  



 Прикрепите только .zip файл к Вашему электронному письму.  
 Предупредите получателя, что ему необходимо будет установить плагин Scorch на его компьютер.   
  

 
Sibelius использует один и тот же формат для обеих платформ. Партитуру между этими платформами можно 
перемещать без какого-либо преобразования - см. ниже. Оба формата используют систему Unicode - 
стандартный набор международных символов. Это означает, что специальные символы  
(например, буквы с акцентами) автоматически будут преобразовываться между платформами Mac и Windows. 
Музыкальные и текстовые шрифты также заменяются разумно - (глава "Эквиваленты шрифтов"). Файлы 
Sibelius имеют расширение .sib. На платформе Mac файлы Sibelius имеют расширение “SIBE”, и “SIBL”.  
 

Открытие партитур, созданных на Mac на платформе Windows  
 
Если Вы хотите открыть партитуру, созданную на платформе Mac, и которая находится на CD-R или другом 
диске, удостоверьтесь, что диск отформатирован под Windows - тогда как Mac может считывать диски, 
записанные на Windows, Windows не может считывать диски, записанные на Mac. Чтобы открыть файл, 
созданный на Mac в Sibelius на платформе Windows, Вам, вероятно, придется добавлять расширение .sib 
вручную. Хотя Sibelius добавляет это расширение по умолчанию как на Windows, так и на Mac, некоторые 
пользователи Mac предпочитают не использовать расширения вообще. Это вызывает проблемы на Windows, 
потому что расширение указывает Windows на то, что это файл именно Sibelius. Чтобы добавить расширение 
файла в Windows, щелкните правой кнопкой мыши на значке файла (в "Моем компьютере" или «Проводнике») и 
выберите опцию "Переименовать". Измените расширение, а затем нажмите [Enter] (на основной клавиатуре). 
Если последует запрос на подтверждение, согласитесь, нажав кнопку "Да". Как только Вы переименовали файл, 
его можно будет открыть двойным щелчком.  
 

Открытие партитур, созданных на Windows на платформе Mac  
 
Если Вы хотите открыть партитуру на Mac, созданную на платформе Windows, просто перейдите File->Open и 
дважды щелкните по названию файла в диалоговом окне. 
 

 
Создать новую партитуру в Sibelius можно несколькими способами: 
  

 импортировать музыкальные данные из другой программы в формате MusicXML или MIDI  
 отсканировать печатные ноты с помощью плагина PhotoScore,  
 записать музыкальные данные, используя микрофон через плагин AudioScore.  

 
И конечно, можно создать партитуру с нуля, одним из двух способов:  
 
 Если нет открытых партитур: щелкните по вкладке New в окне Quick Start   
 Если есть открытые партитуры: во вкладке File нажмите кнопку New, или используйте комбинацию [Ctrl+N] 

или  

[  N].  

Нотное полотно (Manuscript paper) 
 
В любом случае Вы закончите просмотром списка шаблонов, которые называются нотными полотнами, 
организованными в папки с отображением ярлыков для каждого полотна. Варианты полотен наряду с другими 
параметрами, включают различные комбинации инструментов и оптимизированы под определенные задачи и 
воспроизведение Вашей партитуры. Необязательно использовать именно предложенные инструменты - не 
стесняйтесь менять инструменты или добавлять новые. Однако лучше использовать нотное полотно, 
содержащее инструменты, чем начать с пустой страницы, даже если инструментарий не соответствует Вашему 
представлению, потому как остальные опции уже предустановленны в шаблонах полотен и соответствуют 
определенному типу музыкальных данных. В Sibelius доступно более 60 нотных полотен, категоризированных 
следующим образом: 
 

 : Базовые шаблоны нотного стана со скрипичным ключом, шаблоны нотного стана с басовым No category
ключом, и пустого нотного стана, без инструментальных пресетов 

 : набор шаблонов нотных полотен для духовых, маршевых, и школьных оркестров Band
 : шаблоны медных, деревянных и струнных трио, квартетов и квинтетов Chamber Groups
 : различные хоровые нотные полотна, несколько шаблонов для певцов с двумя нотоносцами Choral and Song



(“закрытая партитура”), несколько шаблонов органного или фортепианного аккомпанемента, плюс шаблоны 
Вокал+клавишные 

 : шаблоны для колокольчиков на одном нотном стане и на двух нотных станах Handbells
  несколько шаблонов с использованием "рукописных" собственных издательских стилей, включая  Jazz:

Биг-бэнд и Jazz квартет 
 : шаблоны ансамблей Mariachi и Salsa Latin
 : шаблоны для оркестров барабанов (перкуссии) и духовых оркестров, плюс Marching Band and Percussion

шаблоны для больших маршевых и военных духовых оркестров 
 : шаблоны для классических, романтических, современных, концертных, струнных и Orchestral

кинематографических оркестров.  
 

: Оркестровые и кинематографические полотна были разработаны композитором сериала Примечание
The Simpsons Альфом Клюэзном (Alf Clausen) и его сыном Кайлом Клэюзном (Kyle Clausen). 
 

 : шаблоны для классов школы Карла Орффа, где музыка является основой и соединяет Orff Instruments
вместе движение, пение, игру и импровизацию 

 : шаблоны для гитарных партий поп групп и R&B коллективов Rock and Pop
 : различные нотные полотна для гитарной нотации и табулатуры, включая лютневую Solo Instruments

табулатуру, плюс шаблон Фортепиано+Lead гитара. 
 
Чтобы более бегло просмотреть категории, любую категорию можно свернуть, щелкнув по ее заголовку, или 
удерживая клавишу [Shift], щелкнуть по любому заголовку, чтобы свернуть или развернуть все категории сразу. 
Если Вы хотите создать учебный черновик с нуля, легче всего выбрать шаблон из File->Teaching->Worksheet 
Creator - (глава "Worksheet Creator - плагин для создания черновиков"). Вы можете также создать свои 
собственные нотные полотна - (глава "Экспортирование нотного полотна").  
 

Конфигурация партитуры  
 
Чтобы создать партитуру, не меняя инструменты, или не изменяя первоначальную тональность или музыкальный 
размер, просто дважды щелкните по выбранному нотному полотну. Чтобы модифицировать нотное полотно, 
дважды щелкните по нему. После этого отобразится развернутая версия шаблона, вместе с его опциями на 
правой стороне.  
 

 



Используя эти опции можно изменить размер страницы, ориентацию, сменить инструменты, музыкальный 
размер, ключевые знаки, первоначальный темп, и даже определить заголовок и композитора пьесы.  

 
: Любой элемент можно всегда добавить или изменить в любое время. Примечание

 

 
Sibelius 7 полностью совместим с предыдущими версиями как для Windows, так и для Mac, включая файлы, 
сохраненные в редакциях Sibelius Student, Sibelius First и G7. Перейдите в File->Open, или в окне Quick Start 
выберите опцию Open Other, и откройте партитуру как обычно.  
 

Диалоговое окно Update Score  
 
Поскольку каждая новая версия Sibelius включает новые функции, при открытии партитуры, созданной в 
предыдущих версиях Sibelius, отображается диалоговое окно Update Score, в котором можно выбрать аспекты 
Вашей партитуры, которые Вы хотите обновить. Вы можете выбрать только те опции, которые не были доступны 
в ранней версии Sibelius. Опции главного диалогового окна Update Score являются самыми важными:  
 

 
 

 : Если этот чебокс отмечен, Sibelius создаст активные партии по умолчанию  Create dynamic parts
(глава "Работа с партиями").  

  если этот чебокс отмечен, Sibelius будет пытаться Use same sounds as previous version (where possible):
оставить тот же самый звук инструмента для каждого нотного стана Вашей партитуры, какой использовался при 
воспроизведении этой партитуры в Sibelius 4 или более ранних версиях. Эта опция активируется только в том 
случае, если  у Вас установлено совместимое звуковое устройство, которое использовалось при работе над 
партитурой в предыдущей версии.  

 : Если этот чебокс отмечен, Sibelius будет учитывать любые репризы в партитуре. Обычно этот Play repeats
чебокс не активен, так как эта опция активирована по умолчанию во всех версиях, кроме самых ранних версий 
Sibelius.  

 : Если этот чебокс отмечен, Sibelius будет сохранять любые сделанные Keep custom beam groupings
изменения группировки ребер в партитуре. Обычно этот чебокс должен быть отмечен, гарантируя, что при 
открытии партитуры группировка ребер не изменится: если Вы впоследствии захотите сбросить группировку 
ребер в их новые значения по умолчанию, используйте опцию Notes->Reset Beam Groups  
(глава "Группировка ребер").  
 
 



 : Если этот чебокс отмечен, активируется функция автоматического предотвращения Use Magnetic Layout
наложения знаков в Вашей партитуре. Рекомендуется оставить этот чебокс активированным: если впоследствии 
Вы захотите отключить функцию Magnetic Layout, снимите чебокс Layout-> Magnetic Layout  
(глава "Функция Magnetic Layout").  

 : Если этот чебокс отмечен, аккордовые символы Sibelius 5 и более ранних версий Convert chord symbol text
будут преобразованы в более новые, более интеллектуальные аккордовые символы. Оригинальное отображение 
аккордовых символов будет сохраняться до тех пор, пока Вы не выберете их и не используете опцию Layout-
>Reset Design. Sibelius может обновлять только те аккордовые символы, которые используют один из 
собственных шрифтов аккордовых символов Sibelius. Если Вы использовали шрифт аккордовых символов, не из 
библиотеки Sibelius, эти символы преобразованы не будут (глава "Аккордовые символы").  
 
Щелчок на кнопке More Options открывает страницу с дополнительными опциями, которые помогут улучшить 
отображение Вашей партитуры:  
 

 
 

 : Если этот чебокс отмечен, фразировочные лиги, т.е. лиги, объединяющие Magnetic slurs on normal notes
группу нот, исполняемых легато привязываются выше или ниже к нормальным нотам (имеется в виду нотам на 
одном нотном стане) таким образом, чтобы любой конец лиги "примагничивался" к ближайшей ноте или аккорду 
(глава "Фразировочные Лиги")  

 : функционирует точно так же как и опция, описанная выше, но Magnetic slurs on cross-staff notes
применяется только к нотам, расположенным на разных нотных станах, но объединенных ребром в одну группу.  
(глава "Фразировочные Лиги")  
 



 : Если этот чебокс отмечен, нотные штили по обе стороны средней линии Version 1.3 stem length rule
удлиняются на 0.25 пунктов, в отличие от того, как предпочитается большинством печатных и издательских 
систем 

 Правило расположения голосов в Sibelius, начиная с версии 2, было усовершенствовано, поэтому чтобы 
применить это новое правило к партитурам более ранних версий, активируйте опцию Version 2 voice positioning 

 (глава "rule Голоса")  
 : Если этот чебокс отмечен, цифры и квадратные скобки произвольных ритмических нотных Magnetic tuplets

фигур (tuplets) будут располагаться по правилам - выше или ниже нот в этих фигурах согласно их позиции на 
нотном стане (глава "Триоли и другие произвольные ритмические нотные фигуры")  

 : Если этот чебокс отмечен, написание нот при Adjust note spelling in transposing instruments in remote keys
транспонировании инструментов, будет корректироваться энгармонически (глава "Инструменты")  

 : Если этот чебокс отмечен, используется Allow note and staff spacings to be contracted
усовершенствованный алгоритм распределения свободного места для сжатия пространства по горизонтали и по 
вертикали в партитурах более ранних версий (глава "Распределение пространства между нотами")  

 : Если этот чебокс отмечен, активируются правила позиционирования ребер, Optical beam positions
которые разработчики называют "Optical beam positions" (глава "Позиционирование ребер")  

 :  Если этот чебокс отмечен, активируют правила позиционирования связующих лиг, которые Optical ties
разработчики называют "Optical ties" (глава "Связующие лиги")  

 : Если этот чебокс отмечен, отменяются любые изменения параметров Optical note spacing
позиционирования нот в Вашей партитуре, и активируется правило позиционирования нот "Optical note spacing" 
Sibelius ("Распределение пространства между нотами ")  

  (скрытые ноты и паузы не влияют на Hidden notes and rests don’t affect stem directions and rests
направление штилей и пауз): Этот чебокс должен быть отмечен, за исключением тех случаев, если Вы знаете, 
что у Вас есть перевернутые штили и изменены вертикальные позиции пауз в партитуре, и Вы хотите, чтобы эти 
изменения были сохранены.  

 : Этот чебокс должен быть отмечен, за исключением тех случаев, если Version 5 vertical text positioning rule
Вы знаете, что у Вас есть измененные вертикальные позиции текстовых объектов (например, номера тактов) для 
корректирования текста, который как Вам, кажется, слишком приближен к нотному стану следующего инструмента 
и изменяет количество линий нотного стана.  

 : Если этот чебокс отмечен, применяется усовершенствованное Adjust stem lengths to avoid beamed rests
правило позиционирования ребер, перемещая их таким образом, чтобы они не сталкивались с паузами - (глава 
"Позиционирование ребер").  

 : Если этот чебокс отмечен, активируется функция automatic Draw automatic cautionary accidentals
cautionary accidentals Sibelius, которая отображает напоминающий случайный знак альтерации для ноты со 
знаком альтерации в предыдущем такте ("Знаки альтерации").  

 : Если этот чебокс отмечен, применяется Position slurs on mixed stem notes above the notes
усовершенствованное правило направления фразировочных лиг: если все ноты под лигой имеют штили вверх, 
лига изогнется ниже этих нот, а если у какой-либо из нот штиль будет направлен вниз, лига изогнется выше нот 
(глава "Фразировочные Лиги").  

 : Если этот чебокс отмечен, изменяется длина произвольных Extend tuplet brackets to last note in tuplet
ритмических нотных фигур, улучшая расположение оконечностей квадратных скобок этих фигур  
(глава "Триоли и другие произвольные ритмические нотные фигуры"). 
 

Другие полезные настройки  
 
Есть несколько более тонких настроек, которые могут понадобиться после загрузки партитуры, созданной в 
предыдущих версиях Sibelius:  
 

 : рекомендуется активировать чебокс New articulation positioning rule: Касаемо артикуляций
Appearance>Engraving Rules->Articulations. Эта опция изменит позицию артикуляций, которые отображаются 
вне нотного стана на нотах со штилями вниз выше средней линии нотного стана, а также изменит позицию 
артикуляций (например, staccato, tenuto) внутри нотного стана на нотах со штилями вверх выше средней линии 
нотного стана (например, перевернутые ноты). Если Вы до этого перемещали какие-либо артикуляции для 
корректировки позиционирования, выделите эти ноты и используйте опцию Layout->Reset Position, чтобы 
увидеть, как работает опция New articulation positioning rule. Кроме того, если Вы предпочитаете следовать 
правилу, согласно которому акценты должны быть расположены внутри лиги, отметьте соответствующий чебокс 
Inside slur для этой артикуляции.  
 
 
 
 
 



 : в дополнение к активированию опции Automatic cautionary accidentals  Касаемо знаков альтерации
(описанной выше): Appearance->Engraving Rules- Accidentals & Dots, можно также отключить опцию Reset 
accidentals to current key signature on clef change: Appearance->Engraving Rules->Clefs & Key Signatures, 
которая, если отмечена, гарантирует, что ноты, следующие за сменой ключа в середине такта, будут 
следовать согласно нормальным правилам относительно знаков альтерации до изменения ключа в этом же 
самом такте.  

 : может оказаться полезным отключение опции  Касаемо редактирования расстояния нотных станов
Justify bothstaves of grand staff instruments и конфигурация значений опций extra spaces:  
Appearance->Engraving Rules->Staves.  

 : активируйте новую опцию Касаемо параметров отображения динамики на вокальных нотоносцах
Vocal staff  в диалоговом окне Edit Instrument для вокальных инструментов Вашей партитуры: Home-
>Instruments->Edit Instruments, затем активируйте новую опцию Different default position on vocal staves: в 
House Style->Default Positions для вкладки Expression и различных стилей отображения вилок и установите 
подходящие значения, чтобы расположить их выше нотного стана по умолчанию.  

 : выделение объектов и использование опции Layout->Reset Position Касаемо функции Magnetic Layout
существенно улучшает отображение Вашей партитуры.  
 
Большинство вышеупомянутых опций можно быстро сбросить в их рекомендуемые параметры, импортируя один 
из фабричных издательских стилей - (глава "Собственный издательский стиль") 
 

 
Если Вы не слишком осведомлены об интерфейсе MIDI, в главе "MIDI для новичков" объясняется, что такое 
MIDI-файлы. Если Вас интересует, где можно скачать MIDI-файлы, смотрите главу "Импорт MIDI-файлов" ниже. 
 

Импорт MIDI-файлов 
 
MIDI-файл открывается точно так же, как и типичный файл Sibelius: просто перейдите File->Open (комбинация 

[Ctrl+O] или [ O]), определите местоположение файла (на Windows, MIDI-файлы обычно имеют расширение 
.mid), и нажмите "Открыть" (Open). В диалоговом окне можно установить опции импортирования (описанные 
ниже). Обычно, достаточно всего лишь нажать OK. Некоторые MIDI-файлы не содержат данных о смене тембров 
(program changes). Это означает, что для таких файлов необходимо назначить инструменты вручную. В этом 
случае, последует предупреждение о том, что название инструментов, звуки, ключи, и другие детали могут быть 
некорректными и Вам необходимо будет либо скорректировать эти параметры вручную, либо (что 
предпочтительно) использовать корректный MIDI-файл с правильными данными о смене тембров, и повторно 
импортировать этот "правильный" MIDI-файл. Если Вы находите, что импортированный MIDI-файл выглядит не 
так, как ожидалось, попробуйте изменить некоторые параметры импортирования - (глава "Опции 
импортирования"). После этого, правильно импортированный MIDI-файл можно воспроизвести, 
отредактировать, сохранить, распечатать и создать из него партии, как обычно. Импортированные MIDI-файлы 
воспроизводятся с каждым нюансом оригинальной секвенции - с точным значением velocity и тактированием 
каждой ноты - благодаря функции Sibelius Live Playback (глава "Функция Live Playback").  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Опции импортирования 
 

 
 
Вкладка MIDI File диалогового окна Open MIDI File разделена на несколько секций и включает следующие опции:  
 
Сек ция  Instruments 
 

 Чебокс : Если этот чебокс отмечен, в меню ниже можно выбрать спецификацию, MIDI file uses this sound set
которая будет использоваться патчем и номером банка при воспроизведении MIDI файла. Это помогает 
распознать инструменты данного MIDI файла. Типичный MIDI файл использует спецификацию General MIDI (GM).  

 Чебокс : Опция полезна в том случае, если загружаемый MIDI файл включает Only one staff per track
несколько треков, например, партию фортепиано, где для правой руки отведен один трек, а для левой руки 
другой трек. В этом случае, если чебокс Only one staff per track отмечен, партии обеих рук будут записаны на 
один нотный стан, а не на два.   

 Чебокс : По умолчанию эта опция отключена, т.е. Sibelius сам будет выбирать порядок Keep track order
инструментов. Если этот чебокс отмечен, инструменты сохраняются в том же самом порядке, как и треки в MIDI-
файле.  

 Чебокс : Если этот чебокс отмечен, Sibelius использует название каждого трека в качестве Keep track names
названия инструмента. Если этот чебокс снят, названия инструментов используются по умолчанию для 
инструментов, которые выбрал Sibelius  

 Чебокс : Если этот чебокс отмечен (по умолчанию), Sibelius будет скрывать пустые Hide empty staves
нотоносцы партитуры. Это полезно в том случае, если MIDI-файл включает пустые треки, за исключением 
коротких пассажей. Скрытие пустых нотоносцев может облегчить чтение партитуры.  
 
Сек ция  Timecode & H it Points 
 

 Чебокс : Если этот чебокс отмечен, Sibelius будет преобразовать все маркеры Import markers as hit points
MIDI файла в специальные hit point маркеры создаваемой партитуры. Если этот чебокс снят, Sibelius будет 
импортировать маркеры MIDI файла в качестве стандартных текстовых объектов.  
Hit Point - маркер, отображающий временную позицию воспроизведения. Используется для синхронизации с 
другим источником звука или видео для согласования темпа MIDI-секвенции с этими источниками.  

 Радиокнопка : Если эта радиокнопка отмечена, Sibelius устанавливает Use frame rate from SMPTE header
частоту кадров в опциях Play->Video и Time->Timecode and Duration согласно установкам MIDI-файла - (глава 
"Смещение синхросигнала").  



 Радиокнопка  - Если эта радиокнопка отмечена, частота кадра устанавливается Use frame rate
пользователем.  

 
Сек ция  Transcroption 
 

 Радиокнопка :  Если эта радиокнопка отмечена, Sibelius будет импортировать любые Use tab for guitars
гитарные треки MIDI-файла на табулатурные нотоносцы. Если эта опция будет отключена, гитарные партии будут 
импортированы на обыкновенные нотные нотоносцы.  

 Чебокс : Если этот чебокс (обычно) отмечен Sibelius при необходимости будет Use multiple voices
использовать двухголосие для более чистой нотации.  

 Чебокс : Если этот чебокс отмечен, все обозначения метронома становятся Show metronome marks
видимыми. Если в партитуре присутствуют отклонения темпа (например, rits. и accels.), эту опцию можно 
отключить, чтобы скрыть отображение этих отклонений. При этом партитура будет выглядеть более чистой, но 
все отклонения будут воспроизводиться, как положено.  
 
Опции секции Document Setup позволяют выбрать Размер страницы (меню Paper Size), Собственный 
издательский стиль (меню House Style) и Ориентацию страницы партитуры - книжная (Portrait) или альбомная 
(Landscape).  
Опции вкладки Notation диалогового окна Open MIDI File описываются в главе "Опции алгоритма Flexi-Time".  
 

Рекомендуемые опции импортирования  
 
Вероятная комбинация опций диалогового окна Open MIDI file зависит от ряда различных факторов, например:  
 

 Если Вы импортируете MIDI-файл для создания чистой нотации, отключите опции Staccato и Tenuto во 
вкладке Notation и попробуйте несколько различных значений опции Minimum note duration  

 Если Вы импортируете MIDI-файл только для воспроизведения, не имеет значения, какие опции Вы выберите, 
поскольку Sibelius будет всегда воспроизводить MIDI-файл точно так, как он звучит, используя функцию Live 
Playback  

 Если Вы импортируете файл, созданный кем-то еще, и вероятно на другом устройстве, например, MIDI-файл, 
загруженный с Интернета, в меню MIDI file uses this sound set необходимо выбрать спецификацию, под которой 
создавался этот MIDI файл  

 Если Вы импортируете MIDI-файл, и знаете, что этот файл записан под спецификацией звукового банка 
General MIDI, удостоверьтесь, что в меню MIDI file uses this sound set выбрана опция General MIDI.  
 

 



Параметры на вкладке Notation по умолчанию будут функционировать в большинстве случаев правильно, если:  
 
 Чебокс Adjust rhythms отмечен  
 В меню Minimum note duration выбрана шестнадцатая нота  
 Чебоксы Staccato и Tenuto отмечены.  
 

 Если Вы используете MIDI-файл, в котором ритм абсолютно точен, например, при использовании функции 
Quantize, чебокс Adjust rhythms необходимо снять.  

 Если в меню Minimum note duration Вы выбрали неправильную длительность (обычно большей 
длительности) - например, восьмые ноты, тогда как MIDI-файл содержит длинные пассажи шестнадцатых нот - 
Sibelius, скорее всего не сможет правильно детектировать эти пассажи.  
 
Опции триолеобразны х фигур  
 

 Значение Simple означает, что триолеобразные фигуры будут нотироваться только в том случае, если они 
включают равные по длительности ноты  

 Значения Moderate и Complex применяются для более нестандартных ритмических фигур.  
 

: если в MIDI-файле используется хотя бы одна триолеобразная фигура Примите во внимание
(например, триоль), необходимо выбрать значение Simple. В противном случае, триолеобразная фигура 
будет считана неправильно!  С другой стороны, если, скажем, Вы устанавливаете все триолеобразные 

фигуры в значение Complex, Sibelius может детектировать сложные ритмические триолеобразные фигуры там, 
где Вы бы их совсем не ожидали.  
 

Функция пакетного преобразования  
 

Sibelius включает плагин для пакетного преобразования целой 
папки с MIDI файлами. Перейдите Home-> Plug-ins-> Batch 
Processing-> Convert Folder of MIDI Files. В диалоговом окне 
найдите папку для преобразования и нажмите OK. После этого 
каждый MIDI-файл, который найдет программа в этой папке, 
будут преобразованы в файлы Sibelius.  
 
 
 
 
 
 

 

Чистка MIDI-файлов  
 
Поскольку MIDI-файлы не содержат данных нотации, после их загрузки в Sibelius, они могут выглядеть несколько 
"засоренными". Ниже приводятся некоторые советы для улучшения результатов как до, так и после 
преобразования:  

 Если в MIDI-файле используются нестандартные номера тембров, например, если MIDI файл 
конфигурировался для воспроизведения на нетипичном MIDI устройстве, Sibelius не сможет правильно 
идентифицировать инструменты, и они могут отображаться с неправильными характеристиками, например, с 
неправильными ключами или в неправильном порядке.  

 Если в MIDI-файле канал №10 используется для тональных инструментов, т.е. инструментов, имеющих 
определенную высоту тона, эти инструменты могут интерпретироваться Sibelius как перкуссионные. Это зависит 
от выбранного соответствующего MIDI устройства при загрузке MIDI-файла. Если эта ситуация имеет место, 
попробуйте повторно импортировать MIDI файл, изменив устройство в меню MIDI file uses this sound set.  

 Если MIDI-файл квантован, т.е. выровнен ритмически не полностью или неправильно, можно обнаружить, 
что ритм нотирован не так чисто, как могло ожидаться. Если у Вас есть доступ к секвенсору, Вы можете 
переквантовать файл и повторно загрузить его в Sibelius. Альтернативно, попробуйте использовать опцию Note 
Input-> Flexi-time-> Renotate Performance, которая может, как перераспределить голоса, так и разумно 
переквантовать музыкальные данные - (глава "Чистка партитуры после применения алгоритма Flexi-
time"). Тип чистки, которая обычно требуется после загрузки MIDI-файла - сделать нотоносцы нетональной 
перкуссии более четкими - (глава "Перкуссия"). При импортировании в Sibelius MIDI-файла с нетональной 
перкуссией, каждый перкуссионный звук преобразовывается в нотную головку на соответствующей позиции 
нотного стана (т.е. на линию или пространство), на 5 линий (соответствуя набору ударных инструментов). Если 
для звука перкуссии не определился тип инструмента, Sibelius подставляет типичную нотацию, используя 
крестообразные и ромбовидные нотные головки в пустых позициях на нотном стане.  



Иногда можно обнаружить нежелательные паузы между нотами, или нежелательные унисоны (когда две нотные 
головки располагаются на одной высоте тона). Чтобы это исправить, используйте плагины Remove Rests и 
Remove Unison Notes в Note Input-> Plug-ins-> Simplify Notation - (глава "Работа с плагинами").  
 

Смещение синхросигнала 
 
Функция MIDI SMPTE смещает импортированное событие и устанавливает параметры опции Start Time (время 
начала воспроизведения) в диалоговых окнах Play-> Video and Time->Timecode and Duration. Эта функция 
может также использоваться для установки частоты кадров (frame rate), которая будет использоваться для тайм-
кода партитуры. Однако, из-за того, что функция MIDI SMPTE описывает не все форматы частоты кадров, 
используемые секвенсорами, если Вам известна частота кадров, которую Вы фактически хотите использовать, 
выберите значение в меню Set frame rate на странице MIDI File диалогового окна Open MIDI File. Если Вы не 
сталкивались с этой функцией и не знаете, как ее применить правильно - просто оставьте опции в значениях по 
умолчанию.  

Технические детали  
 
Sibelius может импортировать MIDI-файлы типов 0 и 1. При импортировании, Sibelius разумно вычисляет, какие 
применить инструменты (используя названия треков, если они присутствуют, или, вычисляя их по звучанию), и в 
состоянии сделать отличия в каждом треке, скажем, между скрипкой и альтом, кларнетом и бас кларнетом, или 
сопрано и альтом. Sibelius корректирует ритм, используя алгоритм Flexi-time, и сохраняет такое количество 
данные MIDI-сообщений, которое Вы определяете (например, обозначения метронома, данные смены тембров и 
так далее). Sibelius также автоматически уменьшает размер нотного стана под размер страницы, если в MIDI 
файле слишком много инструментов.  
 

Скачивание MIDI файлов с интернета  
 
Есть множество онлайн ресурсов для скачивания MIDI-файлов. Если Вы ищете определенную пьесу, можно 
использовать поиск на www.google.com. Альтернативно Вы можете посетить один из нижеперечисленных 
сайтов:  
 
 : общедоступный домен. Более 16 000 файлов классической музыки  www.prs.net
 : поисковая система для определения MIDI-файлов поп-музыки в сети  www.musicrobot.com
 : превосходный сайт хоровой музыки с тысячами файлов  www.cpdl.org
  файл любого гимна, включая слова.  www.cyberhymnal.org:
 
Не все файлы на этих ресурсах сконвертированы в MIDI формат - некоторые могут быть в формате Finale, PDF 
или другом формате. Некоторые могут быть даже в аудиоформате, например, в MP3 файл, который также можно 
открыть в Sibelius. Поэтому перед скачиванием, не поленитесь проверить формат файла. Sibelius может открыть 
файлы в различных форматах - смотрите соответствующие темы в этой главе. Как только Вы нашли MIDI-файл и 
скачали его, откройте Sibelius, и выполните порядок действий, описанный в главе "Импорт MIDI-файла".  
 

 
Встроенный конвертор файлов MusicXML 2.0 в Sibelius позволяет открывать MusicXML файлы, созданные во 
многих музыкальных программах, включая Finale 2003 и версий позднее и в программе SharpEye. Цель работы 
конвертера заключается в экономии Вашего времени, которое ушло бы на преобразование каждой партитуры.  
 

Что такое MusicXML?  
 
MusicXML - это формат для обмена структурированными данными между программами-нотаторами. Этот 
формат обеспечивает наилучший способ передачи нотации между различными программами, в отличие от других 
форматов, например от MIDI-файлов.  
 

Создание MusicXML файлов в программе Finale  
 
Порядок создания MusicXML файлов в программе Finale, зависит от ее версии:  
 

  или версия позднее: перейдите File->MusicXML->Export  Finale 2006
  (только на Windows): перейдите Plug-ins->MusicXML Export.  Finale 2003, 2004 или 2005
 Если Вы используете  или  на Mac OS X, или используете версию Finale младше Finale 2004 Finale 2005

версии 2003 на Windows, необходимо приобрести отдельный плагин Dolet Finale для экспортирования MusicXML 
файлов, который можно купить на www.recordare.com. Если Вы используете плагин Dolet для экспорта 
MusicXML файлов, перейдите Plug-ins-> MusicXML-> Export MusicXML.  
 



Импортирование MusicXML файлов  
 

 
 

MusicXML файл обычно имеет одно из двух расширений: несжатые MusicXML файлы имеют расширение .xml, а 
сжатые MusicXML файлы версии 2.0, или более поздних версий имеют расширение .mxl. Sibelius может открыть 
MusicXML файлы с любым расширением. Импортирование файла MusicXML идентично типичному открытию 

файлов Sibelius: просто перейдите File->Open (или используйте клавиатурную комбинацию [Ctrl+O] или [  O]), 
определите местоположение файла, и щелкните "Открыть" (Open). После этого отобразится диалоговое окно, 
которое включает следующие опции:  
 

 Чебокс : отмечен по умолчанию. Если открываемый файл Use page and staff size from MusicXML file
MusicXML имеет версию 1.1 или более позднюю, Sibelius будет пытаться сохранить страницу и размер нотного 
стана MusicXML файла. Если этот чебокс снят, размер и ориентацию импортированного MusicXML файла можно 
установить вручную, а Sibelius будет использовать размер нотного стана по умолчанию в соответствии с 
издательским стилем, выбранным ниже в меню House Style.  

 Чебокс : также отмечен по умолчанию. Если MusicXML файл  Use layout and formatting from MusicXML file
имеет версию 1.1 или более позднюю, Sibelius попытается сохранить расположение и форматирование 
(например, расстояния между нотоносцами, разрывы страниц, и т.д.) оригинального MusicXML файла. Если этот 
чебокс снят, Sibelius эффективно разблокирует формат партитуры, используя ее расположение и 
форматирование по умолчанию.  

 Меню  позволяет при импортировании выбрать Ваш собственный издательский стиль. Если в House style
меню Вы оставите опцию Unchanged, Sibelius будет использовать свой собственный издательский стиль по 
умолчанию.  

 
: Если выбирается другой издательский стиль, размер страницы и размер нотного стана, Примечание

определенный в этом издательском стиле, в партитуре использоваться не будут, если Вы не снимите 
чебокс Use page and staff size from MusicXML file.  

 
 Чебокс : Если этот чебокс отмечен, Sibelius будет пытаться автоматически Let Sibelius choose instruments

идентифицировать инструменты в MusicXML файле. Если, по Вашему мнению, Sibelius неправильно 
интерпретирует инструменты, повторно импортируйте файл, и отключите эту опцию. Инструменты в файле с 
левой стороны отображают отдельные партии инструментов 

 Для того чтобы нотоносцы отображали Инструменты в списке файлов, выберите инструменты из списка 
Sibelius, которые Вы хотите использовать для каждой партии (предпочтительно в диалоговом окне Instruments): 
либо дважды щелкнув по инструменту, либо щелчком на кнопке Add, чтобы добавить Инструмент и создать 
список на правой стороне диалогового окна. Когда все партии назначены на инструменты Sibelius, активируется 
кнопка OK, щелчок по которой откроет файл.  

 Чебокс : Если этот чебокс отмечен, Sibelius будет использовать Use instrument names from MusicXML file
название инструментов MusicXML файла. Если Вы хотите, чтобы Sibelius использовал свои собственные 
названия инструментов по умолчанию, этот чебокс необходимо снять.  



Предупреждающие сообщения  
 
Некоторые MusicXML файлы могут содержать ошибки, которые отражаются в диалоговых окнах и обозначают 
каждую ошибку и папку, в файле которой эта ошибка произошла. Ошибки могут быть трех типов:  
 

 Фатальные ошибки (Fatal errors): отображается в том случае, если файл полностью не совместим с 
форматом XML. При этом файл не может быть открыт вообще. 

 Ошибки совместимости (Validation errors): отображается в том случае, если файл совместим с форматом 
XML, но определенный синтаксис элементов MusicXML содержит ошибки или противоречивости. Sibelius 
попытается открыть файл, но партитура может загрузиться с неожиданными проблемами  

 Предупреждения (Warnings): Иногда при открытии XML файлов контрольное устройство проверки 
совместимости отображает предупреждения, которые обычно не препятствуют открытию файла.  
 

Импортирование файлов MusicXML, сохраненных в секвенсоре  
 
Алгоритм импортирования MusicXML файлов в Sibelius оптимизирован для обеспечения наилучших результатов 
при импортировании MusicXML файлов, сохраненных в программе Finale или при использовании плагина Dolet 
Finale. В определенных случаях некоторые MusicXML файлы, особенно созданные в секвенсорах, которые не 
поддерживают возможность нотации, могут быть не в состоянии произвести какую либо ясную нотацию вообще.  
 

Поддерживаемые версии 
 
Конвертор MusicXML файлов в Sibelius базируется на версии формата MusicXML 2.0. Файлы, созданные в 
формате MusicXML более ранних версий, открываются также корректно, при условии, что они совместимы 
(прошли проверку на валидность). Файлы, созданные с будущими версиями MusicXML, также должны открыться, 
несмотря на то, что новые функции импортироваться не будут. Sibelius может открыть только те MusicXML 
файлы, которые используют высокоуровневый формат определения типа документа partwise.dtd. Если файл 
использует формат timewise.dtd, необходимо будет использовать XSLT конвертор для преобразования timewise 
MusicXML файла в partwise MusicXML файл. Один из таких конвертеров доступен на сайте: 
http://www2.freeweb.hu/mozartmusic/pttp/converter.html. 
 

Функция пакетного преобразования 
 
Sibelius включает плагин для пакетного преобразования целой папки с MusicXML файлами. Для этого, перейдите 
Home->Plug-ins->Batch Processing->Convert Folder of MusicXML Files. После этого Sibelius преобразует все 
MusicXML файлы, которые он найдет в указанной папке, сохраняя каждый файл в качестве партитуры Sibelius с 
тем же самым названием, что и оригинальный MusicXML файл. 
 

Ограничения, накладываемые при импортировании MusicXML файлов 
 

Функция Ограничения 

Артикуляции (Articulations) 
Некоторые артикуляции могут быть расположены на 
неправильную сторону ноты или аккорда. Технические 
элементы и элементы украшений не импортируются. 

Тактовые черты (Barlines) 

Если у различных нотоносцев будут различные типы 
тактовых черт одновременно, Sibelius будет 
использовать тип тактовой черты самой верхней 
партии. Жирные, жирно-тонкие и жирно-жирные 
тактовые черты не импортируются. 

Ребра (Beams) Подребра (sub-beams) не импортируются 

Аккордовые символы (Chord symbols) 
 

Некоторые аккордовые символы не импортируются (в 
случае, когда они используют функциональный 
элемент). Формат MusicXML определяет, что все 
аккордовые символы располагаются в партии только 
наверху нотного стана. Хорошим примером могут 
послужить неаполитанские, итальянские, французские, 
немецкие, педальные и Тристан, которые 
импортируются как мажорные трезвучия. Если 
функциональный элемент не присутствует в элементе 
гармонии, аккордовый символ не импортируется. 



Ключи (Clefs) 

Специальные перкуссионные и табулатурные ключи, 
доступные в формате MusicXML, будут заменены 
ближайшим соответствующим ключом, доступным в 
Sibelius. Формат MusicXML не способен к 
дифференциации между ключами в начале или в конце 
такта. 

Ноты, расположенные на разных нотных станах, но 
объединенные ребром в одну группу (Cross-stave 

notes) 

MusicXML файлы, которые используют несколько 
голосов на нотоносцах, могут импортировать 
некоторые ноты на неправильные нотные станы. 
Файлы, включающие аккорды с нотами на различных 
нотоносцах, импортируются неправильно. 

Конечные репризы (End repeat lines) 
Позиционирование конечных реприз, возможно, 
придется корректировать вручную после 
импортирования.  

Ключевые знаки (Key signatures) 

В качестве элементов лада распознаются только 
мажорный и минорный лады. Если пятый элемент 
будет отсутствовать, ключевой знак будет 
импортирован как атональный. Другие дополнительные 
ключевые элементы (например, key-step и key-alter) 
игнорируются. Если партия включает несколько нотных 
станов, ключевые знаки с одного или более нотоносцев 
могут быть пропущены. Ключевые знаки, которые были 
помещены после тактовой черты в некоторых других 
нотаторах, могут расположиться перед тактовой чертой 

Расположение страницы (Layout) 
Sibelius может использовать только один размер 
страницы для всей импортируемой партитуры. 
Объекты, которые только графически смещаются в 
файле, могут повлиять на воспроизведение в Sibelius.  

Лирика (Lyrics) Смех, гул, концевая строка, конец абзаца, и 
редакционные элементы игнорируются.  

Обозначения метронома (Metronome marks) 

Обозначения метронома, включающие длительности 
нот 256, 128, 64 и бревис, Sibelius не импортируются. 
Все обозначения метронома принимают позиции 
Sibelius по умолчанию. Только обозначения метронома 
самого верхнего нотоносца самой верхней партии 
читаются импортером XML. Обозначения метронома 
могут дублироваться, если самая верхняя партия в 
файле включает несколько нотных станов. 

Украшения (Ornaments) Некоторые украшения не импортируются. 
Импортируются морденты, трели и группетто.   

Паузы (Rests) 

Дополнительные паузы, получившиеся из нескольких 
голосов на том же самом нотном стане, удаляются 
автоматически, но некоторые дополнительные паузы 
могут остаться, например, в пассажах Нот, 
расположенных на разных нотных станах (cross-staff 
passages).   

Фразировочная лига (Slur) 
Атрибут продления не импортируется. Позиция 
атрибутов объекта не импортируются. Размещение и 
ориентация не импортируются.   

Символы (Symbols) Символы не импортируются 
Нотные станы (Staves) Изменение типа нотного стана не импортируется. 

Штили (Stems) Значение штилей none и double не импортируется. 

Текст (Text) 

Некоторые текстовые элементы импортируются 
посредством элемента динамики, но ни один из 
атрибутов динамики не импортируется. Определенные 
элементы фигурного баса, например, круглые скобки, 
элизия и расширения, не импортируются. 
Направляющий элемент не импортируется.   

Связующие лиги (Ties) 

Элемент связующей лиги игнорируется полностью. 
Импортируются только связующие лиги, определенные 
залигованным элементом. Номерной атрибут 
игнорируется. Все связующие лиги импортируются в 
качестве цельных связующих лиг. Позиция, 
размещение, ориентация, bezier-смещение, атрибуты 
bezier-x и bezier-y не импортируются.   



Музыкальные размеры (Time signatures) 

Sibelius не импортирует составные музыкальные 
размеры (например, 2/4 + 6/8), а импортируется только 
значения числителя (например, 2+3 / 4). Элементы 
Senza-misura не импортируются. Значение отдельного 
номерного атрибута символа не импортируется (если 
таковой встречается, он импортируется как обычно). 
Если на разных нотных станах обозначены разные 
музыкальные размеры, Sibelius будет использовать 
музыкальный размер самого верхнего нотного стана.   

Триолеобразные фигуры (Tuplets) 

Некоторые версии плагина Dolet для Finale помещают 
элементы начала и конца триолеобразных фигур в 
неправильное расположение, которое может 
инициировать неправильное импортирование 
триолеобразных фигур. Размещение триолеобразных 
фигур, позиция, тип, цифра, квадратная скобка и 
форма линии не импортируются.  

 


